
Q .1Q .1 A t  whic h internat ional  event d id  Indian arc her  Deepika Kumari  win a  bronzeA t whic h internat ional  event d id  Indian arc her  Deepika Kumari  win a  bronze
medal  on 1 1  M ay  2 0 2 5?medal  on 1 1  M ay  2 0 2 5?

A nsA ns 1. Archery World Cup Stage 2, Shanghai
2. Asian Archery Championships, Delhi
3. Archery World Cup Final, Paris
4. World Archery Championships, Berlin

Q .2Q .2 Whic h of the fo l lowing is  NO T a c opper  produc ing s tate?Whic h of the fo l lowing is  NO T a c opper  produc ing s tate?
A nsA ns 1. Jharkhand

2. Madhya Pradesh
3. Punjab
4. Rajasthan

Q .3Q .3 In M ay  2 0 2 5,  whic h of the fo l lowing init iat ives  was  launc hed by  the S ec ur it iesIn M ay  2 0 2 5,  whic h of the fo l lowing init iat ives  was  launc hed by  the S ec ur it ies
and E xc hange Board of Ind ia  ( S E B I)  to  enhance c orporate governance andand E xc hange Board of Ind ia  ( S E B I)  to  enhance c orporate governance and
trans parenc y  in the s ec ur it ies  market?trans parenc y  in the s ec ur it ies  market?

A nsA ns 1. Investor Protection and Grievance Redressal Portal
2. Digital Audit Trail System
3. Unified Payments Interface for Stock Trading
4. Dedicated Portal for Related Party Transactions (RPT)

Q .4Q .4 In a  par l iamentary  s y s tem, who is  ty pic al ly  referred to  as  the head of theIn a  par l iamentary  s y s tem, who is  ty pic al ly  referred to  as  the head of the
government?government?

A nsA ns 1. Governor
2. Prime Minister
3. President
4. Chief Minister
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Q . 5Q . 5 When was  Dr.  Bhimrao A mbedkar  awarded the Bharat  Ratna?When was  Dr.  Bhimrao A mbedkar  awarded the Bharat  Ratna?
A nsA ns 1. 1990

2. 1952
3. 1960
4. 1980

Q .6Q .6 Whic h of the fo l lowing Pala  k ings  founded the V ikramas hi la  Univers ity  nearWhic h of the fo l lowing Pala  k ings  founded the V ikramas hi la  Univers ity  near
Bhagalpur  in B ihar?Bhagalpur  in B ihar?

A nsA ns 1. Dharmapala
2. Devpala
3. Mahipala I
4. Gopala

Q .7Q .7 Who among the fo l lowing was  the founding leader  of the Faraiz i  movement?Who among the fo l lowing was  the founding leader  of the Faraiz i  movement?
A nsA ns 1. Shah Walliullah

2. Titu Mir
3. Shariatullah
4. Sayyid Ahmad Barelwi

Q .8Q .8 What is  the as s ured minimum pens ion per  month under  the Unified Pens ionWhat is  the as s ured minimum pens ion per  month under  the Unified Pens ion
S c heme,  approved by  the C abinet  on 24  A ugus t  2 0 24 ,  for  ind iv iduals  after  aS c heme,  approved by  the C abinet  on 24  A ugus t  2 0 24 ,  for  ind iv iduals  after  a
minimum of 1 0  y ears  of  s erv ice?minimum of 1 0  y ears  of  s erv ice?

A nsA ns 1. ₹5,000

2. ₹15,000
3. ₹7,500
4. ₹10,000

Q .9Q .9 A s  of 3 0  O c tober  2 0 24 ,  who among the fo l lowing c hairs  the S enior  M anagementA s  of 3 0  O c tober  2 0 24 ,  who among the fo l lowing c hairs  the S enior  M anagement
G roup of the United Nations?G roup of the United Nations?

A nsA ns 1. António Guterres
2. Csaba Kőrösi
3. Volker Turk
4. Amina J Mohammed
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Q .1 0Q .1 0 Whic h of the fo l lowing es tabl is hed India's  firs t  s emic onduc tor  fabr ic at ion unit  inWhic h of the fo l lowing es tabl is hed India's  firs t  s emic onduc tor  fabr ic at ion unit  in
Dholera?Dholera?

A nsA ns 1. 
2. 
3. 
4. 

Q .1 1Q .1 1 Whic h lake l ies  to  the s outh of the M ahanadi  delta?Whic h lake l ies  to  the s outh of the M ahanadi  delta?
A nsA ns 1. Pulicat lake

2. Chilika lake
3. Lonar lake
4. Umiam lake

Q .1 2Q .1 2 In whic h of the fo l lowing y ears  was  the S upreme C ourt  of  Ind ia  es tabl is hed?In whic h of the fo l lowing y ears  was  the S upreme C ourt  of  Ind ia  es tabl is hed?
A nsA ns 1. 1949

2. 1947
3. 1950
4. 1951

Q .1 3Q .1 3 The Kazan Dec larat ion:  S trengthening M ult i lateral is m for  Jus t  G lobalThe Kazan Dec larat ion:  S trengthening M ult i lateral is m for  Jus t  G lobal
Development and S ec ur ity  is  as s oc iated with whic h of the fo l lowing internat ionalDevelopment and S ec ur ity  is  as s oc iated with whic h of the fo l lowing internat ional
groupings?groupings?

A nsA ns 1. G20
2. Association of Southeast Asian Nations
3. BRICS
4. Shanghai Cooperation Organisation

Q .1 4Q .1 4 Where is  the Wild  A s s  S anc tuary  loc ated in Ind ia?Where is  the Wild  A s s  S anc tuary  loc ated in Ind ia?
A nsA ns 1. Nandadevi

2. Begusarai
3. Ranthambore
4. Rann of Kutch
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Q .1 5Q .1 5 Whic h of the fo l lowing ins t itut ions  was  opened by  A nnette A c kroy d in C alc utta inWhic h of the fo l lowing ins t itut ions  was  opened by  A nnette A c kroy d in C alc utta in
1 873  with the aim of promoting equal  educ at ion for  women?1 873  with the aim of promoting equal  educ at ion for  women?

A nsA ns 1. Hindu Mahila Vidyalaya
2. Arya Mahila College
3. Queen Mary's College
4. SNDT Women's University

Q .1 6Q .1 6 Who among the fo l lowing was  one of the founding members  of the Hindus tanWho among the fo l lowing was  one of the founding members  of the Hindus tan
Republ ic an A s s oc iat ion?Republ ic an A s s oc iat ion?

A nsA ns 1. Khudiram Bose
2. Bhagat Singh
3. Chandra Shekhar Azad
4. Jogesh Chatterjee

Q .1 7Q .1 7 What was  the approximate l iterac y  rate of Kerala  as  per  the 2 0 1 1  cens us?What was  the approximate l iterac y  rate of Kerala  as  per  the 2 0 1 1  cens us?
A nsA ns 1. 90%

2. 99%

3. 85%
4. 94%

Q .1 8Q .1 8
A nsA ns 1. 

2. 
3. 
4. 

Q .1 9Q .1 9 The internat ional  boundary  between India  and Pak is tan is  NO T s hared by  whic h ofThe internat ional  boundary  between India  and Pak is tan is  NO T s hared by  whic h of
the fo l lowing s tates?the fo l lowing s tates?

A nsA ns 1. Gujarat
2. Himachal Pradesh

3. Rajasthan
4. Punjab
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Q .2 0Q .2 0 The Batt le of  C haus a was  fought between ____________ ,  in 1 53 9 .The Batt le of  C haus a was  fought between ____________ ,  in 1 53 9 .

A nsA ns 1. 
2. 
3. 
4. 

Q .2 1Q .2 1 Q  is  the hus band of A .  W is  the s on of A .  W is  the mother  of L .  C  is  the wife of L .Q  is  the hus band of A .  W is  the s on of A .  W is  the mother  of L .  C  is  the wife of L .
How is  L  related to  A ?How is  L  related to  A ?

A nsA ns 1. Brother
2. Son
3. Son's daughter
4. Daughter's son

Q .2 2Q .2 2 What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘× ’What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘× ’
and ‘−’ are interc hanged and ‘÷ ’ and ‘+ ’ are interc hanged?and ‘−’ are interc hanged and ‘÷ ’ and ‘+ ’ are interc hanged?
2 64  + 8  − 1 2  ÷  61  ×  70  = ?2 64  + 8  − 1 2  ÷  61  ×  70  = ?

A nsA ns 1. 390
2. 372
3. 379
4. 387

Q .2 3Q .2 3 E ac h of the d igits  in the number 3 4 1 982 6 is  arranged in as cending order  fromE ac h of the d igits  in the number 3 4 1 982 6 is  arranged in as cending order  from
left  to  r ight .  What wi l l  be the produc t  of the d igits  whic h are s ec ond from theleft  to  r ight .  What wi l l  be the produc t  of the d igits  whic h are s ec ond from the
left  and third  from the r ight  in the new number thus  formed?left  and third  from the r ight  in the new number thus  formed?

A nsA ns 1. 
2. 
3. 
4. 

Section : Logical Reasoning
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Q .24Q .24 In the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ing certainIn the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ing certain
mathematic al  operat ions  to  the firs t  number.  Whic h numbers  s hould  replace Xmathematic al  operat ions  to  the firs t  number.  Whic h numbers  s hould  replace X
and Y,  s o  that  the pattern fo l lowed by  the two numbers  on the left  s ide of : :  isand Y,  s o  that  the pattern fo l lowed by  the two numbers  on the left  s ide of : :  is
s ame as  that  on the r ight  s ide of : :  ?s ame as  that  on the r ight  s ide of : :  ?

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc hdown the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h
as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  intoas  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into
1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  

X  :  69 : :  43  :  YX :  69 : :  43  :  Y
A nsA ns 1. X = 35 , Y = 85

2. X = 35 , Y = 89
3. X = 32 , Y = 88
4. X = 34 , Y = 82

Q .2 5Q .2 5 Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion.Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion.

( L eft)  4  1  2  6  4  5 7  1  9  2  1  0  1  9  2  8  0  1  7  1  2  9  0  3  5 2  0  9  4  ( Right)( L eft)  4  1  2  6  4  5 7  1  9  2  1  0  1  9  2  8  0  1  7  1  2  9  0  3  5 2  0  9  4  ( Right)

How many  odd d igits  are immediately  preceded by  a  perfec t  s quare and als oHow many  odd d igits  are immediately  preceded by  a  perfec t  s quare and als o
immediately  fo l lowed by  an even d igit  ( 1  is  a ls o  a  perfec t  s quare) ?immediately  fo l lowed by  an even d igit  ( 1  is  a ls o  a  perfec t  s quare) ?

A nsA ns 1. Three
2. Four
3. Five
4. Two
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Q .2 6Q .2 6 2  is  related to  8  fo l lowing a certain logic .  Fo l lowing the s ame logic ,  7  is  related to2  is  related to  8  fo l lowing a certain logic .  Fo l lowing the s ame logic ,  7  is  related to
3 43.  To  whic h of the given options  is  9  related ,  fo l lowing the s ame logic ?3 43.  To  whic h of the given options  is  9  related ,  fo l lowing the s ame logic ?

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc hdown the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h
as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  intoas  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into
1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )

A nsA ns 1. 729
2. 720
3. 716
4. 732

Q .2 7Q .2 7 S elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairsS elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairs
given below.  Both pairs  fo l low the s ame pattern.given below.  Both pairs  fo l low the s ame pattern.
LO Q  :  NQ RLO Q  :  NQ R
C FI  :  E HJC FI  :  E HJ

A nsA ns 1. DEN : FDO
2. FLR : HNS
3. GLP : INO
4. EMR : FOS

Q .2 8Q .2 8 Refer  to  the given letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting toRefer  to  the given letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to
be done from left  to  r ight  only .be done from left  to  r ight  only .
( L eft)  L  N I  F  G  O  V  E  V  I  S  U G  Z  U Z  E  A  T  I  R F ( Right)( L eft)  L  N I  F  G  O  V  E  V  I  S  U G  Z  U Z  E  A  T  I  R F ( Right)
How many  s uc h vowels  are there eac h of whic h is  immediately  preceded by  aHow many  s uc h vowels  are there eac h of whic h is  immediately  preceded by  a
c ons onant and als o  immediately  fo l lowed by  a  c ons onant?c ons onant and als o  immediately  fo l lowed by  a  c ons onant?

A nsA ns 1. Eight
2. Seven
3. Five
4. Four
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Q .2 9Q .2 9 S ix  boxes ,  A ,  B,  C ,  D,  E ,  and F,  are kept one over  the other  but not  neces s ar i ly  inS ix  boxes ,  A ,  B,  C ,  D,  E ,  and F,  are kept one over  the other  but not  neces s ar i ly  in
the s ame order.  A  is  kept s ec ond from the top.  O nly  two boxes  are kept betweenthe s ame order.  A  is  kept s ec ond from the top.  O nly  two boxes  are kept between
D and F.  E  is  kept immediately  above C .  D  is  kept immediately  below A .  B  is  keptD and F.  E  is  kept immediately  above C .  D  is  kept immediately  below A .  B  is  kept
immediately  above A .  How many  boxes  are kept between D and C ?immediately  above A .  How many  boxes  are kept between D and C ?

A nsA ns 1. One
2. Two
3. Four
4. Three

Q .3 0Q .3 0 S elec t  the c orrec t  mirror  image of the given figure when the mirror  is  placed atS elec t  the c orrec t  mirror  image of the given figure when the mirror  is  placed at
M N as  s hown below.M N as  s hown below.

A nsA ns 1. 

2. 

3. 

4. 
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Q .3 1Q .3 1 S elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two s et  ofS elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two s et  of
pairs  given below.  Both pairs  fo l low the s ame pattern.  pairs  given below.  Both pairs  fo l low the s ame pattern.  

M C W :  E UO  M C W :  E UO  
A KU :  S C MA KU :  S C M

A nsA ns 1. 
2. 
3. 
4. 

Q .3 2Q .3 2 Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .
C ounting to  be done from left  to  r ight  only .C ounting to  be done from left  to  r ight  only .
( L eft)  ( L eft)  a  e c  g e b c  d  h b f  i  e d  b d  c  e b d  i  e h e b a  e c  g e b c  d  h b f  i  e d  b d  c  e b d  i  e h e b ( Right)( Right)
How many  letters  are there in the above s er ies ,  eac h of whic h is  immediatelyHow many  letters  are there in the above s er ies ,  eac h of whic h is  immediately
preceded by  a  vowel  and immediately  fo l lowed by  a  c ons onant?preceded by  a  vowel  and immediately  fo l lowed by  a  c ons onant?

A nsA ns 1. One
2. Two
3. More than three
4. Three

Q .3 3Q .3 3 E ac h letter  in the word 'O C E A N'  is  c hanged to  the letter  immediately  fo l lowing itE ac h letter  in the word 'O C E A N'  is  c hanged to  the letter  immediately  fo l lowing it
in the E ngl is h a lphabetic al  order  and then al l  the letters  are arranged inin the E ngl is h a lphabetic al  order  and then al l  the letters  are arranged in
alphabetic al  order.  Whic h of the fo l lowing letters  wi l l  be third  from the left  in thealphabetic al  order.  Whic h of the fo l lowing letters  wi l l  be third  from the left  in the
new group of letters  formed?new group of letters  formed?

A nsA ns 1. E
2. F
3. M
4. O
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Q .3 4Q .3 4 In the fo l lowing tr iads ,  eac h group of letters  is  related to  the s ubs equent oneIn the fo l lowing tr iads ,  eac h group of letters  is  related to  the s ubs equent one
fol lowing a certain logic .  S elec t  from the given options ,  the one that  fo l lows  thefo l lowing a certain logic .  S elec t  from the given options ,  the one that  fo l lows  the
s ame logic .s ame logic .

S UNG  -  US NG  -  G US NS UNG  -  US NG  -  G US N
FO UR -  O FUR -  RO FUFO UR -  O FUR -  RO FU

A nsA ns 1. DUSK - DSUK - KSUD
2. QUIT - UQIT - TUIQ

3. MATE - AMTE - ATEM
4. ZEAL - EZAL - LEZA

Q .3 5Q .3 5 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

1 5 1 5 ?  ?  1 8  1 8  9  9  2 5 2 5 0  0  3 63 6
A nsA ns 1. 11

2. 13
3. 12
4. 14

Q .3 6Q .3 6 S ahi  ranked 4 9S ahi  ranked 4 9t ht h  from the top and 1 9 from the top and 1 9t ht h  from the bottom in his  c las s .  How many from the bottom in his  c las s .  How many
s tudents  are there in the c las s?s tudents  are there in the c las s?

A nsA ns 1. 66
2. 68
3. 65
4. 67

Q .3 7Q .3 7 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

3 4 ,  4 1 ,  55,  76 ,  1 0 4 ,  ?3 4 ,  4 1 ,  55,  76 ,  1 0 4 ,  ?
A nsA ns 1. 137

2. 140
3. 138
4. 139

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .3 8Q .3 8 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus terBas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ter
pairs  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus ter  pairpairs  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus ter  pair
DO E S  NO T belong to  that  group?  DO E S  NO T belong to  that  group?  
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their
pos it ion in the letter- c lus ter. )pos it ion in the letter- c lus ter. )

A nsA ns 1. JM-OG
2. PS-UM
3. GJ-LC

4. MP-RJ

Q .3 9Q .3 9 E ac h of the d igits  in the number 80 3 64 561  is  arranged in as cending order  fromE ac h of the d igits  in the number 80 3 64 561  is  arranged in as cending order  from
left  to  r ight .  The pos it ion(s)  of  how many  d igits  wi l l  remain unc hanged asleft  to  r ight .  The pos it ion(s)  of  how many  d igits  wi l l  remain unc hanged as
c ompared to  that  in the or iginal  number?c ompared to  that  in the or iginal  number?

A nsA ns 1. One
2. Three

3. Four
4. Two

Q .4 0Q .4 0 Three of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form aThree of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form a
group.  Whic h word- pair  DO E S  NO T belong to  that  group?group.  Whic h word- pair  DO E S  NO T belong to  that  group?

( NO TE :  The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not( NO TE :  The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not
be related to  eac h other  bas ed on the number of letters  /number ofbe related to  eac h other  bas ed on the number of letters  /number of
c ons onants/vowels  in the word . )c ons onants/vowels  in the word . )

A nsA ns 1. India : Asia
2. Egypt : Africa
3. Nepal :  Australia
4. Romania : Europe

Section : General English and Comprehension
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Q .4 1Q .4 1 S elec t  the mos t appropr iate A NTO NYM  of the given word .S elec t  the mos t appropr iate A NTO NYM  of the given word .

S lenderS lender
A nsA ns 1. Narrow

2. Elegant
3. Fragile
4. Chubby

Q .4 2Q .4 2 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

He arr ived ______ bec aus e he d id  not  want to  be late.He arr ived ______ bec aus e he d id  not  want to  be late.
A nsA ns 1. slowly

2. early
3. nearby
4. always

Q .43Q .43 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.

'S at  on the fence''S at  on the fence'
A nsA ns 1. Supported both sides equally.

2. Took an active role in a decision.
3. Avoided making a decision or commitment.
4. Remained confident throughout the discussion.

Q .4 4Q .4 4 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .
The c at  c has ed the _______ around the garden.The c at  c has ed the _______ around the garden.

A nsA ns 1. mice
2. mosquitoes
3. beatles
4. ants
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Q .4 5Q .4 5 S elec t  the option that  has  near ly  the s ame meaning as  the under l ined group ofS elec t  the option that  has  near ly  the s ame meaning as  the under l ined group of
words .words .

M ar is s a M ay er,  the former G oogle and Yahoo exec utive,  bel ieves  that  A rt ific ia lM ar is s a M ay er,  the former G oogle and Yahoo exec utive,  bel ieves  that  A rt ific ia l
Intel l igence s hould  s impl ify  our  l ives  but Intel l igence s hould  s impl ify  our  l ives  but gives  not ice beforehand es pec ial ly  ofgives  not ice beforehand es pec ial ly  of
danger  or  ev i ldanger  or  ev i l  the real  batt le for  the future wi l l  be determined by  how the US  and the real  batt le for  the future wi l l  be determined by  how the US  and
C hina embrace this  tec hnology .C hina embrace this  tec hnology .

A nsA ns 1. advises
2. detects
3. warns
4. discusses

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

The Famous Five − Julian, Dick, Anne, George and Timmy the dog − arrive at Kirrin Cottage.

"There won't be time for any adventure these hols," said Dick, regretfully as they walked
down the lane to Kirrin Cottage. Red poppies danced along the way, and in the distance, the
sea shone as blue as cornflowers. "Only two weeks and we go back to school! Well, let's
hope the weather keeps fine. I want to bathe six times a day!"
Soon they were all sitting around the tea-table at Kirrin Cottage, and their Aunt Fanny was
handing round plates of her nicest scones and tea-cakes The children chattered eagerly,
unaware that a shadowy figure watched them from the cliffs − a figure who would soon
draw them into a perilous quest for hidden treasure. Timmy growled softly sensing danger,
but George ruffled his fur, "Don't worry, Timmy. We'll find the adventure − we always do.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6
Q .4 6Q .4 6 What is  the meaning of the given word?What is  the meaning of the given word?

Q ues tQ ues t
A nsA ns 1. Neglect

2. Search
3. Queer
4. Surrender
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

The Famous Five − Julian, Dick, Anne, George and Timmy the dog − arrive at Kirrin Cottage.

"There won't be time for any adventure these hols," said Dick, regretfully as they walked
down the lane to Kirrin Cottage. Red poppies danced along the way, and in the distance, the
sea shone as blue as cornflowers. "Only two weeks and we go back to school! Well, let's
hope the weather keeps fine. I want to bathe six times a day!"
Soon they were all sitting around the tea-table at Kirrin Cottage, and their Aunt Fanny was
handing round plates of her nicest scones and tea-cakes The children chattered eagerly,
unaware that a shadowy figure watched them from the cliffs − a figure who would soon
draw them into a perilous quest for hidden treasure. Timmy growled softly sensing danger,
but George ruffled his fur, "Don't worry, Timmy. We'll find the adventure − we always do.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47
Q .47Q .47 What is  the main idea highl ighted in the pas s age?What is  the main idea highl ighted in the pas s age?

A nsA ns 1. The importance of keeping pets
2. The perils of the sea and cliffs
3. Childhood curiosity and adventure
4. Family picnics
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

The Famous Five − Julian, Dick, Anne, George and Timmy the dog − arrive at Kirrin Cottage.

"There won't be time for any adventure these hols," said Dick, regretfully as they walked
down the lane to Kirrin Cottage. Red poppies danced along the way, and in the distance, the
sea shone as blue as cornflowers. "Only two weeks and we go back to school! Well, let's
hope the weather keeps fine. I want to bathe six times a day!"
Soon they were all sitting around the tea-table at Kirrin Cottage, and their Aunt Fanny was
handing round plates of her nicest scones and tea-cakes The children chattered eagerly,
unaware that a shadowy figure watched them from the cliffs − a figure who would soon
draw them into a perilous quest for hidden treasure. Timmy growled softly sensing danger,
but George ruffled his fur, "Don't worry, Timmy. We'll find the adventure − we always do.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8
Q .4 8Q .4 8 What fl owers  d id  the c hi ldren s ee on the way  to  Kirr in C ottage?What fl owers  d id  the c hi ldren s ee on the way  to  Kirr in C ottage?
A nsA ns 1. Blue cornflowers

2. Bluebells
3. White poppies
4. Red poppies
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

The Famous Five − Julian, Dick, Anne, George and Timmy the dog − arrive at Kirrin Cottage.

"There won't be time for any adventure these hols," said Dick, regretfully as they walked
down the lane to Kirrin Cottage. Red poppies danced along the way, and in the distance, the
sea shone as blue as cornflowers. "Only two weeks and we go back to school! Well, let's
hope the weather keeps fine. I want to bathe six times a day!"
Soon they were all sitting around the tea-table at Kirrin Cottage, and their Aunt Fanny was
handing round plates of her nicest scones and tea-cakes The children chattered eagerly,
unaware that a shadowy figure watched them from the cliffs − a figure who would soon
draw them into a perilous quest for hidden treasure. Timmy growled softly sensing danger,
but George ruffled his fur, "Don't worry, Timmy. We'll find the adventure − we always do.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9
Q .4 9Q .4 9 What is  s ugges ted by  T immy 's  growling?What is  s ugges ted by  T immy 's  growling?
A nsA ns 1. He senses impending danger.

2. He wants to run along the sea.
3. He is thirsty and hungry.
4. He dislikes scones and does not want to have them.
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

The Famous Five − Julian, Dick, Anne, George and Timmy the dog − arrive at Kirrin Cottage.

"There won't be time for any adventure these hols," said Dick, regretfully as they walked
down the lane to Kirrin Cottage. Red poppies danced along the way, and in the distance, the
sea shone as blue as cornflowers. "Only two weeks and we go back to school! Well, let's
hope the weather keeps fine. I want to bathe six times a day!"
Soon they were all sitting around the tea-table at Kirrin Cottage, and their Aunt Fanny was
handing round plates of her nicest scones and tea-cakes The children chattered eagerly,
unaware that a shadowy figure watched them from the cliffs − a figure who would soon
draw them into a perilous quest for hidden treasure. Timmy growled softly sensing danger,
but George ruffled his fur, "Don't worry, Timmy. We'll find the adventure − we always do.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50
Q . 50Q . 50 What is  the O PPO S ITE  of the given word?What is  the O PPO S ITE  of the given word?

Per i lousPer i lous
A nsA ns 1. Dangerous

2. Evil
3. Risky
4. Safe

Q . 51Q . 51 ]न_`लbख त]न_`लbख त   ]वक gh]वक gh   मjमj   सेसे   लो को noलो को no   केके   सहीसही   अथtअथt   काका   चयनचयन   क रjक रj ।।
‘‘ ऊंचीऊंची   दुका नदुका न   फ� काफ� का   प क वा नप क वा न ’ ’ काका   अथtअथt   हैहै

A nsA ns 1. बड़ी दुकान
2. �ादर�हत भोजन
3. खाली दुकान
4. केवल बा� �दशtन

Section : General Hindi and Comprehension

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q . 52Q . 52 ‘‘ द� तhद� तh   त लेत ले   उँ ग लीउँ ग ली   द बा नाद बा ना ’ ’ मुहा वरेमुहा वरे   काका   �ा�ा   अथtअथt   हैहै ??
A nsA ns 1. जानकार से बात �छपाना

2. अपनी उँगली काटना
3. �दन काटे न कटना
4. आ�यtचिकत होना

Q . 53Q . 53 ‘‘ अमरअमर ’ ’ काका   प य� यवा चीप य� यवा ची   श�श�   हैहै ??
A nsA ns 1. जीव

2. अन�र
3. उ�
4. नयन

Q . 54Q . 54 �दए गए �वक	प� म
 से उ�यमी का सट�क �वलोम श�द चु�नए-

A nsA ns 1. अधम

2. ]न��मी
3. अ��यम

4. उ�म

Q . 55Q . 55 �द ए�द ए   ग एग ए   वा �वा �   मjमj   �र o�र o   �ा न�ा न   केके   `लए`लए   उ प युoउ प युo   का र कका र क   चुनjचुनj ।।
वहवह   रा मरा म  ……….   ……… .  ना मना म   लेक रलेक र   ना चनेना चने   लगालगा ।।

A nsA ns 1. के
2. का
3. क�
4. को
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C omprehens ion:C omprehens ion:
ग�¡श के आधार पर ]न_`लbखत �£h के उ�र दी`जए-

‘महाका¤’ को �बंध का¤ भी कहते ह¥। पा�ा¦ सा�ह¦ मj इसके `लए ‘एिपक’ श� का �योग िकया जाता है । यह
अ¦ंत �ाचीन का¤ ]वधा है। हमारे यह� रामायण और महाभारत जैसे ]वशाल महाका¤ `लखे गए ह¥, `जªj उपजी¤
क]वय भी कहा जाता है, �hिक य परवत« का¤h और महाका¤h के ¬ोत भी ह¥। इस`लए �ाचीन समय से इस ]वधा
के ��प एवं ल­णh पर ]वचार िकया जाता रहा है। महाका¤ ‘महत्’ और ‘का¤’ इन दो श�h से ¤ु¯° पद है।
‘का¤’ के साथ महत् श� का �योग सबसे पहले वा±ीिक-‘रामायण’ मj ]मलता है-“कत� का¤³ महत: ´ चासौ
मु]नपुंगव: ।” इस पंno से महाका¤ के तीन ल­णh पर �काश पड़ता है- महाका¤ के आकार क� ]वशालता, िकसी
महान च�र· क� �]त¸ा और �णेता क� महानता।भारतीय का¤शा¹ मj संभवत : सवt�थम आचायt भामह ने
महाका¤ के �ºप –]नध�रण का �यास िकया।उªhने �ºप ]वधान के आधार पर का¤ के प¡च भेद िकए ह¥।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56
Q . 56Q . 56 पा �ा ¦पा �ा ¦   सा �ह¦सा �ह¦   मjमj   महा का ¤महा का ¤   केके   `लए`लए   िक सिक स   श�श�   काका   � यो ग� यो ग   िक यािक या   जा ताजा ता   हैहै  ? ?
A nsA ns 1. एिपक

2. कामेड़ी
3. ]वरेचन
4. ·ासदी
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C omprehens ion:C omprehens ion:
ग�¡श के आधार पर ]न_`लbखत �£h के उ�र दी`जए-

‘महाका¤’ को �बंध का¤ भी कहते ह¥। पा�ा¦ सा�ह¦ मj इसके `लए ‘एिपक’ श� का �योग िकया जाता है । यह
अ¦ंत �ाचीन का¤ ]वधा है। हमारे यह� रामायण और महाभारत जैसे ]वशाल महाका¤ `लखे गए ह¥, `जªj उपजी¤
क]वय भी कहा जाता है, �hिक य परवत« का¤h और महाका¤h के ¬ोत भी ह¥। इस`लए �ाचीन समय से इस ]वधा
के ��प एवं ल­णh पर ]वचार िकया जाता रहा है। महाका¤ ‘महत्’ और ‘का¤’ इन दो श�h से ¤ु¯° पद है।
‘का¤’ के साथ महत् श� का �योग सबसे पहले वा±ीिक-‘रामायण’ मj ]मलता है-“कत� का¤³ महत: ´ चासौ
मु]नपुंगव: ।” इस पंno से महाका¤ के तीन ल­णh पर �काश पड़ता है- महाका¤ के आकार क� ]वशालता, िकसी
महान च�र· क� �]त¸ा और �णेता क� महानता।भारतीय का¤शा¹ मj संभवत : सवt�थम आचायt भामह ने
महाका¤ के �ºप –]नध�रण का �यास िकया।उªhने �ºप ]वधान के आधार पर का¤ के प¡च भेद िकए ह¥।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57
Q . 57Q . 57 ग �¡ शग �¡ श   मjमj   � युo� युo   �ा ची न�ा ची न   काका   ]वलो म]वलो म   श�श�   हो गाहो गा --
A nsA ns 1. अव�चीन

2. नया
3. आ�दम
4. प�ष
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C omprehens ion:C omprehens ion:
ग�¡श के आधार पर ]न_`लbखत �£h के उ�र दी`जए-

‘महाका¤’ को �बंध का¤ भी कहते ह¥। पा�ा¦ सा�ह¦ मj इसके `लए ‘एिपक’ श� का �योग िकया जाता है । यह
अ¦ंत �ाचीन का¤ ]वधा है। हमारे यह� रामायण और महाभारत जैसे ]वशाल महाका¤ `लखे गए ह¥, `जªj उपजी¤
क]वय भी कहा जाता है, �hिक य परवत« का¤h और महाका¤h के ¬ोत भी ह¥। इस`लए �ाचीन समय से इस ]वधा
के ��प एवं ल­णh पर ]वचार िकया जाता रहा है। महाका¤ ‘महत्’ और ‘का¤’ इन दो श�h से ¤ु¯° पद है।
‘का¤’ के साथ महत् श� का �योग सबसे पहले वा±ीिक-‘रामायण’ मj ]मलता है-“कत� का¤³ महत: ´ चासौ
मु]नपुंगव: ।” इस पंno से महाका¤ के तीन ल­णh पर �काश पड़ता है- महाका¤ के आकार क� ]वशालता, िकसी
महान च�र· क� �]त¸ा और �णेता क� महानता।भारतीय का¤शा¹ मj संभवत : सवt�थम आचायt भामह ने
महाका¤ के �ºप –]नध�रण का �यास िकया।उªhने �ºप ]वधान के आधार पर का¤ के प¡च भेद िकए ह¥।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58
Q . 58Q . 58 हमा रेहमा रे   यह�यह�   कौ नकौ न   सेसे   दोदो   बड़ेबड़े   महा का ¤महा का ¤   `लखे`लखे   ग एग ए  ? ?
A nsA ns 1. रामच�रतमानस और ]वनय पि·का

2. नागरशोभा और बीजक
3. सूरसागर और सूरसरावली
4. रामायण और महाभारत
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C omprehens ion:C omprehens ion:
ग�¡श के आधार पर ]न_`लbखत �£h के उ�र दी`जए-

‘महाका¤’ को �बंध का¤ भी कहते ह¥। पा�ा¦ सा�ह¦ मj इसके `लए ‘एिपक’ श� का �योग िकया जाता है । यह
अ¦ंत �ाचीन का¤ ]वधा है। हमारे यह� रामायण और महाभारत जैसे ]वशाल महाका¤ `लखे गए ह¥, `जªj उपजी¤
क]वय भी कहा जाता है, �hिक य परवत« का¤h और महाका¤h के ¬ोत भी ह¥। इस`लए �ाचीन समय से इस ]वधा
के ��प एवं ल­णh पर ]वचार िकया जाता रहा है। महाका¤ ‘महत्’ और ‘का¤’ इन दो श�h से ¤ु¯° पद है।
‘का¤’ के साथ महत् श� का �योग सबसे पहले वा±ीिक-‘रामायण’ मj ]मलता है-“कत� का¤³ महत: ´ चासौ
मु]नपुंगव: ।” इस पंno से महाका¤ के तीन ल­णh पर �काश पड़ता है- महाका¤ के आकार क� ]वशालता, िकसी
महान च�र· क� �]त¸ा और �णेता क� महानता।भारतीय का¤शा¹ मj संभवत : सवt�थम आचायt भामह ने
महाका¤ के �ºप –]नध�रण का �यास िकया।उªhने �ºप ]वधान के आधार पर का¤ के प¡च भेद िकए ह¥।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59

Q . 59Q . 59 ग �¡ शग �¡ श   � युo� युo   उ प जी ¤उ प जी ¤   श�श�   काका   अथtअथt   �ा�ा   हैहै  ? ?
A nsA ns 1. `जससे जीवन न½ होता हो

2. `जसके सहारे जीवन चलता हो
3. `जससे भय लगता हो
4. `जसको देखकर ख़ुशी ]मलती है
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C omprehens ion:C omprehens ion:
ग�¡श के आधार पर ]न_`लbखत �£h के उ�र दी`जए-

‘महाका¤’ को �बंध का¤ भी कहते ह¥। पा�ा¦ सा�ह¦ मj इसके `लए ‘एिपक’ श� का �योग िकया जाता है । यह
अ¦ंत �ाचीन का¤ ]वधा है। हमारे यह� रामायण और महाभारत जैसे ]वशाल महाका¤ `लखे गए ह¥, `जªj उपजी¤
क]वय भी कहा जाता है, �hिक य परवत« का¤h और महाका¤h के ¬ोत भी ह¥। इस`लए �ाचीन समय से इस ]वधा
के ��प एवं ल­णh पर ]वचार िकया जाता रहा है। महाका¤ ‘महत्’ और ‘का¤’ इन दो श�h से ¤ु¯° पद है।
‘का¤’ के साथ महत् श� का �योग सबसे पहले वा±ीिक-‘रामायण’ मj ]मलता है-“कत� का¤³ महत: ´ चासौ
मु]नपुंगव: ।” इस पंno से महाका¤ के तीन ल­णh पर �काश पड़ता है- महाका¤ के आकार क� ]वशालता, िकसी
महान च�र· क� �]त¸ा और �णेता क� महानता।भारतीय का¤शा¹ मj संभवत : सवt�थम आचायt भामह ने
महाका¤ के �ºप –]नध�रण का �यास िकया।उªhने �ºप ]वधान के आधार पर का¤ के प¡च भेद िकए ह¥।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60
Q .60Q .60 ग �¡ शग �¡ श   केके   `लए`लए   उ प युoउ प युo   शी ष tकशी षtक   काका   चयनचयन   क� `जएक� `जए ।।
A nsA ns 1. मुoक का¤

2. खंडका¤
3. महाका¤
4. च�रत का¤

Q .61Q .61 Whic h part  of  an email  c ontains  the rec ipient 's  emai l  addres s?Whic h part  of  an email  c ontains  the rec ipient 's  emai l  addres s?
A nsA ns 1. Subject

2. To
3. Body

4. Signature

Q .62Q .62 Whic h of the fo l lowing is  the c orrec t  s ec ur ity  mec hanis m to  c hec k  and make s ureWhic h of the fo l lowing is  the c orrec t  s ec ur ity  mec hanis m to  c hec k  and make s ure
a mes s age was  not  c hanged whi le it  was  being trans mitted?a mes s age was  not  c hanged whi le it  was  being trans mitted?

A nsA ns 1. Virtual Private Network (VPN)
2. Encryption
3. Hashing
4. Digital signature

Section : Basic Knowledge of Computer
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Q .63Q .63 Whic h of the fo l lowing is  c ons idered a s ignific ant r is k  to  c omputer  s ec ur ity ?Whic h of the fo l lowing is  c ons idered a s ignific ant r is k  to  c omputer  s ec ur ity ?
A nsA ns 1. Unpatched software vulnerabilities

2. Strong password policies

3. Regular software updates
4. Comprehensive security training for employees

Q .64Q .64 How to  turn on/off hidden text  in an M S  Word doc ument?How to  turn on/off hidden text  in an M S  Word doc ument?
A nsA ns 1. Go to File -> Options -> Display -> Hidden Text -> Tick or Untick

2. Go to File -> Options -> Language -> Hidden Text -> Tick or Untick
3. Go to File -> Options -> Proofing -> Hidden Text -> Tick or Untick
4. Go to File -> Options -> General -> Hidden Text -> Tick or Untick

Q .65Q .65 Where is  a  received mai l  s tored?Where is  a  received mai l  s tored?
A nsA ns 1. Downloads

2. Outbox
3. Inbox
4. Files

Q .66Q .66 In M S - E xcel  2 0 1 0 ,  to  s elec t  mult iple works heets  for  pr int ing,  c l ic k  the firs tIn M S - E xcel  2 0 1 0 ,  to  s elec t  mult iple works heets  for  pr int ing,  c l ic k  the firs t
works heet ,  ho ld  down the _______ key  on y our  key board and then c l ic k  anyworks heet ,  ho ld  down the _______ key  on y our  key board and then c l ic k  any
addit ional  works heets  y ou want to  inc lude.addit ional  works heets  y ou want to  inc lude.

A nsA ns 1. Esc
2. Tab
3. Ctrl
4. Alt

Q .67Q .67 How c an we s ee Pr int  Preview in a  PDF file?How c an we s ee Pr int  Preview in a  PDF file?
A nsA ns 1. Select Use file production > Output preview

2. Select Use print production > Output preview
3. Select Use print production > Input preview
4. Select Use print preview > Output preview
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Q .68Q .68 In M ic ros oft  Word ,  what is  the func t ion of 'Trac k  C hanges '?In M ic ros oft  Word ,  what is  the func t ion of 'Trac k  C hanges '?
A nsA ns 1. To create a table of contents

2. To insert a hyperlink
3. To keep track of edits made to the document
4. To format text

Q .69Q .69 Whic h of the fo l lowing s tatements  is  INCO RRE C T?Whic h of the fo l lowing s tatements  is  INCO RRE C T?
A nsA ns 1. An MS PowerPoint template is a pattern or blueprint of a slide.

2. Design templates contain a slide with a predefined background.
3. Presentation templates can be opened with MS PowerPoint for the web.
4. Design templates are ready-to-use presentations into which you put your own

information.

Q .70Q .70 _______ are the four  generat ions  of ant iv irus  s oftware in s equence._______ are the four  generat ions  of ant iv irus  s oftware in s equence.
A nsA ns 1. Integrity checking, Heuristic scanners, Activity traps and Full-featured protection

2. Simple scanners, Access control, Heuristic scanners and Full-featured protection
3. Simple scanners, Heuristic scanners, Activity traps and Full-featured protection
4. Simple scanners, Activity traps, Memory resident and Full-featured protection

Q .71Q .71 Whic h of the fo l lowing is  NO T an example of a  ty pe of c omputer  v irus?Whic h of the fo l lowing is  NO T an example of a  ty pe of c omputer  v irus?
A nsA ns 1. Plugin

2. Trojan horse
3. Spyware
4. Worm

Q .72Q .72 Whic h formula entered as  an array  formulaWhic h formula entered as  an array  formula  s hould  be us ed to  generate as hould  be us ed to  generate a
s equence of dates  in M S  E xcel  2 0 1 9 ,  s tart ing from 1  January  2 0 24  ands equence of dates  in M S  E xcel  2 0 1 9 ,  s tart ing from 1  January  2 0 24  and
inc rementing by  7  day s  for  1 0  rows?inc rementing by  7  day s  for  1 0  rows?

A nsA ns 1. =DATE(2024,1,1)+7*ROW(1:10)
2. =SEQUENCE(1,10,DATE(2024,1,1),5)
3. =DATE(2024,1,1)+7ROW(A1:A10)
4. =DATE(2024,1,1)+7SEQUENCE(10)
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Q .73Q .73 Where c an a us er  acces s  the Help feature in mos t  word proces s ing appl ic at ions?Where c an a us er  acces s  the Help feature in mos t  word proces s ing appl ic at ions?
A nsA ns 1. Edit tab

2. Help tab
3. View tab
4. File tab

Q .74Q .74 How c an y ou edit  text  ins ide an M S  PowerPoint  s l ide?How c an y ou edit  text  ins ide an M S  PowerPoint  s l ide?
A nsA ns 1. Right-click the slide and select Add Layout

2. Use the Format tab to change the background
3. Click inside the text box to place the cursor and type or edit text
4. Open Slide Master and select Edit Text

Q .75Q .75
A nsA ns 1. 

2. 
3. 
4. 

Q .76Q .76 Whic h of the fo l lowing is  NO T a feature y ou c an acces s  through the WindowsWhic h of the fo l lowing is  NO T a feature y ou c an acces s  through the Windows
Tas k  M anager?Tas k  M anager?

A nsA ns 1. View running applications
2. Monitor CPU and memory usage
3. Adjust display settings
4. End a non-responsive process

Q .77Q .77 Why  is  it  important to  keep y our  ant iv irus  s oftware up to  date?Why  is  it  important to  keep y our  ant iv irus  s oftware up to  date?
A nsA ns 1. To ensure compatibility with the latest operating system updates

2. To receive the latest virus definitions and security patches

3. To enhance the graphical interface of the software
4. To optimise the performance of your computer
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Q .78Q .78 Whic h of the fo l lowing is  the mos t l ikely  c aus e of the error  mes s age ‘The file s izeWhic h of the fo l lowing is  the mos t l ikely  c aus e of the error  mes s age ‘The file s ize
exceeds  the maximum al lowed s ize’ when attempting to  attac h a file to  an emailexceeds  the maximum al lowed s ize’ when attempting to  attac h a file to  an email
mes s age in G mail?mes s age in G mail?

A nsA ns 1. The file you are trying to attach is a virus.
2. The file you are trying to attach is too large.
3. The file you are trying to attach is a compressed file.
4. The email server has a maximum file size limit.

Q .79Q .79 How c an a us er  enter  a  frac t ion in a  cel l  in M S  E xcel?How c an a us er  enter  a  frac t ion in a  cel l  in M S  E xcel?
A nsA ns 1. By using the Insert > Symbol feature

2. By typing the numerator followed by a slash and then the denominator
3. By using the AutoSum feature
4. By using the Format Cells dialog box

Q .80Q .80 Whic h of the fo l lowing protoc ols  is  thought to  be the s afes t  for  enc ry ptingWhic h of the fo l lowing protoc ols  is  thought to  be the s afes t  for  enc ry pting
s martphone Wi- Fi  traffic ?s martphone Wi- Fi  traffic ?

A nsA ns 1. WPA3
2. WPA
3. WEP
4. HTTP

Q .81Q .81 E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 80  − 7 ) } ]E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 80  − 7 ) } ]
A nsA ns 1. 1607

2. 1682
3. 1467
4. 1537

Q .82Q .82 The average of 6 . 5,  1 0 .6 ,  2 0 .3  and a is  1 2 .  The value of a  is :The average of 6 . 5,  1 0 .6 ,  2 0 .3  and a is  1 2 .  The value of a  is :
A nsA ns 1. 12.6

2. 10.6
3. 11.6
4. 9.6

Section : Quantitative Aptitude
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Q .83Q .83 Rizwan and S afina are c apable of finis hing a tas k  in five day s  and twenty  day s ,Rizwan and S afina are c apable of finis hing a tas k  in five day s  and twenty  day s ,
res pec t ively .  I f  they  begin work ing together,  the amount of t ime required tores pec t ively .  I f  they  begin work ing together,  the amount of t ime required to
finis h the work  would  be:finis h the work  would  be:

A nsA ns 1. 2 days
2. 10 days
3. 5 days
4. 4 days

Q .84Q .84 A  s hopkeeper  s el ls  plas t ic  s poons  at  1 0  for  ₹1 ,  gaining 4 0 %.  How many  plas t icA  s hopkeeper  s el ls  plas t ic  s poons  at  1 0  for  ₹1 ,  gaining 4 0 %.  How many  plas t ic
s poons  d id  he buy  for  ₹1 ?s poons  d id  he buy  for  ₹1 ?

A nsA ns 1. 11
2. 14
3. 13
4. 12

Q .85Q .85 The s um of the ages  of five c hi ldren,  born at  intervals  of  4  y ears  eac h,  is  60The s um of the ages  of five c hi ldren,  born at  intervals  of  4  y ears  eac h,  is  60
y ears .  What is  the age of the middle- mos t c hi ld?y ears .  What is  the age of the middle- mos t c hi ld?

A nsA ns 1. 12
2. 24
3. 16
4. 20

Q .86Q .86 The s el l ing pr ice of 4 0  books  is  equal  to  the c os t  pr ice of 4 6 books .  F ind the los sThe s el l ing pr ice of 4 0  books  is  equal  to  the c os t  pr ice of 4 6 books .  F ind the los s
or  gain percentage.or  gain percentage.

A nsA ns 1. 

2. 
3. 

4. 

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .87Q .87 A n item is  marked 1 86% higher  than its  c os t  pr ice.  E ven after  a l lowing s omeA n item is  marked 1 86% higher  than its  c os t  pr ice.  E ven after  a l lowing s ome
dis c ount ,  the s hopkeeper  earned 43 % profit .  F ind the d is c ount percentagedis c ount ,  the s hopkeeper  earned 43 % profit .  F ind the d is c ount percentage
al lowed by  the s hopkeeper.a l lowed by  the s hopkeeper.

A nsA ns 1. 50%
2. 48%
3. 52%
4. 49%

Q .88Q .88

A nsA ns 1. 
           

2 . 
           

3. 

4. 
            

Q .89Q .89 4  t imes  the pres ent age of L at ika is  1 8  y ears  more than 2  t imes  the pres ent age4  t imes  the pres ent age of L at ika is  1 8  y ears  more than 2  t imes  the pres ent age
of S has hank ,  and 8  t imes  the pres ent age of S has hank  is  8  y ears  les s  than 8  t imesof S has hank ,  and 8  t imes  the pres ent age of S has hank  is  8  y ears  les s  than 8  t imes
the pres ent age of L at ika .  The s um of the pres ent ages  ( in y ears)  of  L at ika andthe pres ent age of L at ika .  The s um of the pres ent ages  ( in y ears)  of  L at ika and
S has hank  is :S has hank  is :

A nsA ns 1. 14
2. 20
3. 19
4. 15

Q .90Q .90 The s um of five numbers  is  655.  The average of the firs t  two numbers  is  76  andThe s um of five numbers  is  655.  The average of the firs t  two numbers  is  76  and
the third  number is  1 1 4 .  F ind the average of the remaining two numbers?the third  number is  1 1 4 .  F ind the average of the remaining two numbers?

A nsA ns 1. 190
2. 195.5
3. 191
4. 194.5
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Q .91Q .91 In an as s embly  elec t ion between four  c andidates  X ,  Y,  Z ,  and M ,  Z  received 2 5,0 0 0In an as s embly  elec t ion between four  c andidates  X ,  Y,  Z ,  and M ,  Z  received 2 5,0 0 0
votes  whi le Y  got  2 0 % more votes  than Z .  From the remaining votes ,  the winnervotes  whi le Y  got  2 0 % more votes  than Z .  From the remaining votes ,  the winner
M  received 60 % votes  and won by  50 ,0 0 0  votes  over  X .  C ons ider ing al l  votesM  received 60 % votes  and won by  50 ,0 0 0  votes  over  X .  C ons ider ing al l  votes
were val id ,  the number of votes  pol led  in the elec t ion was :were val id ,  the number of votes  pol led  in the elec t ion was :

A nsA ns 1. 2,50,000
2. 2,06,080
3. 3,05,000
4. 2,90,500

Q .92Q .92 A  2 1 0  m long train c ros s es  a  man walk ing at  a  s peed of 4 . 5 km/ h in the oppos iteA  2 1 0  m long train c ros s es  a  man walk ing at  a  s peed of 4 . 5 km/ h in the oppos ite
direc t ion in 1 2  s ec onds .  What is  the s peed ( in km/ h)  of  the train?direc t ion in 1 2  s ec onds .  What is  the s peed ( in km/ h)  of  the train?

A nsA ns 1. 61.5 
2. 59.5
3. 58.5
4. 60.5

Q .93Q .93 1 2 % G S T is  lev ied  on a mac hine on its  s el l ing pr ice and a 2 0 % dis c ount is  offered1 2 % G S T is  lev ied  on a mac hine on its  s el l ing pr ice and a 2 0 % dis c ount is  offered
on its  marked pr ice.  I f  ₹4 80  is  paid  for  G S T,  then find the marked pr ice of theon its  marked pr ice.  I f  ₹4 80  is  paid  for  G S T,  then find the marked pr ice of the
mac hine.mac hine.

A nsA ns 1. ₹5,000
2. ₹4,000
3. ₹4,800
4. ₹4,500

Q .94Q .94 Whic h of the fo l lowing frac t ions  is  the larges t?  Whic h of the fo l lowing frac t ions  is  the larges t?  

A nsA ns 1. 

2. 

3. 

4. 
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Q .95Q .95 If  4% of x  =  1 68 ,  then x  is  equal  to :I f  4% of x  =  1 68 ,  then x  is  equal  to :

A nsA ns 1. 8400
2. 8500
3. 4200
4. 4300

Q .96Q .96
A nsA ns 1. 1046

2. 1047
3. 1037
4. 1052

Q .97Q .97 A  pers on’s  expenditure is  4 0 % more than his  s av ings .  I f  his  inc ome is  ₹1 ,2 0 ,0 0 0 ,A  pers on’s  expenditure is  4 0 % more than his  s av ings .  I f  his  inc ome is  ₹1 ,2 0 ,0 0 0 ,
what is  his  expenditure ( in ₹) ?what is  his  expenditure ( in ₹) ?

A nsA ns 1. 54,000
2. 68,000
3. 52,000
4. 70,000

Q .98Q .98 Three pipes  with d iameters  of  3  c m, 4  c m and 6  c m are s imultaneous ly  fil l ing aThree pipes  with d iameters  of  3  c m, 4  c m and 6  c m are s imultaneous ly  fil l ing a
c is tern.  The s mal les t  pipe,  when operat ing alone,  c an fil l  the c is tern in 5 hoursc is tern.  The s mal les t  pipe,  when operat ing alone,  c an fil l  the c is tern in 5 hours
and 7  minutes .  The fl ow of water  in eac h pipe is  proport ional  to  the c ube of itsand 7  minutes .  The fl ow of water  in eac h pipe is  proport ional  to  the c ube of its
d iameter.  What is  the total  t ime ( in minutes)  required for  a l l  the pipes  to  fil l  thediameter.  What is  the total  t ime ( in minutes)  required for  a l l  the pipes  to  fil l  the
c is tern together?c is tern together?

A nsA ns 1. 25
2. 26
3. 24
4. 27
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Q .99Q .99 The pr ice of a  c ar  is  firs t  inc reas ed by  2 0 %, then inc reas ed by  3 0 %, and thenThe pr ice of a  c ar  is  firs t  inc reas ed by  2 0 %, then inc reas ed by  3 0 %, and then
dec reas ed by  50 %.  The net  c hange in the pr ice of the c ar  wi l l  be:dec reas ed by  50 %.  The net  c hange in the pr ice of the c ar  wi l l  be:

A nsA ns 1. none
2. a decrease of 22%
3. an increase of 25%
4. a decrease of 20%

Q .1 0 0Q .1 0 0 A  train when runs  at  an average s peed of 4 0  km/ hr,  reac hes  its  des t inat ion onA  train when runs  at  an average s peed of 4 0  km/ hr,  reac hes  its  des t inat ion on
time.  When its  average s peed bec omes  3 0  km/ hr,  it  reac hes  its  des t inat ion 1 0t ime.  When its  average s peed bec omes  3 0  km/ hr,  it  reac hes  its  des t inat ion 1 0
minutes  late.  F ind the length of the journey .minutes  late.  F ind the length of the journey .

A nsA ns 1. 20 km
2. 60 km
3. 80 km
4. 40 km
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